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KWelcome to Daisy's Garden 2
Also refer to:

Playing Daisy's Garden 2
Editing Garden Files

The Story:
Daisys job is a difficult one: She has to pick all fruits and flowers in her garden AND watch out for the 
greedy marmot and the irksome caterpillar at the same time. As if all this was not enough, she also has to
find her way through the garden    and often enough this is the most difficult part, as it is not always easy 
to find.

What's Behind it?
Daisy's Garden 2 belongs to a new generation of games:

Think n' Run - first think, then run!

Instead of getting rid of aggravating pieces by either shooting or crushing them, Daisy has to try and find 
a way around the obstacles. Daisy's Garden 2 excludes violence and therefore we consider it particularly 
suitable for children.

However, adults also get their moneys worth thanks to some really complicated gardens.

Daisy's Garden 2 also allows you to build your own gardens with your own obstacles. So the fun will not 
end once you have gone through all the set gardens, as everybody who is caught by Daisy fever may 
build new gardens and pass them on to all other Daisy's Garden 2 fans.

Definition of Shareware:
Daisy's Garden 2 is shareware. This means that you are allowed to copy and pass on the game, as often 
you like as long as you will neither make any changes to the game itself nor pass on registration 
passwords or any other passwords. See Registration and License Agreement.

In the shareware version you may try out the game, as often you like, however, there are two restrictions 
as follows:

In every Garden File you can only use the first 6 gardens of altogether 25 - 50 and you can only edit the 
first 3 gardens. 

If you enjoy playing this game, we will then ask you to get registered at a really low rate. The restrictions 
will be dropped once you have got registered; plus, by doing so, you will enable us to develop more 
unique games for you to enjoy. 



Playing Daisy's Garden 2
Also refer to:

Welcome to Daisy's Garden 2 - The Story
Pieces of the Game
Tips and Tricks for Playing

Garden File
Garden
Pieces of the Game
Fields

Daisy has to pick all flowers and harvest all vegetables and fruits. After that she must climb up to the 
highest point of a ladder and only then will she have finished the garden. But do not think it is all over 
then, because the next garden is already waiting for Daisy.

Daisy will often have to dig up things or dig her way through the soil. Sometimes there will be secret 
passages below the ground.    Digging is an important technique, which will make it possible to finish more
difficult gardens.    Daisy cannot jump over things.

It is easy for Daisy to see when she has collected everything, because the ladders will turn green. Now 
she will have to get to the highest point of the garden. 

Daisy can only defend herself against the marmot like this: she can dig holes in which the marmot will fall 
(while Daisy is quickly walking across it) and which will make the caterpillar turn around. Sometimes 
Daisy will find garlic or an invisible making mushroom, which will drive away the marmot or which will 
make her invisible to the marmot and the caterpillar for the time being.

Daisy can open doors to which she has a matching key (it must be the same color as the door). Of 
course, she must have collected them first. 

Sometimes Daisy will also find a clue on how to get through the garden.

Daisy is controlled by the

(Most players will probably prefer using the keyboard)

Keyboard:
Arrow left:

Daisy walks or works on the left.

Arrow right:
Daisy walks or works on the right.

Arrow up:
Daisy climbs up.

Arrow down:
Daisy climbs down or falls down.

Key End or key    "A":
Daisy digs a hole on the left, if she can.

Key Page Down or Key "S":
Daisy digs a hole on the right, if she can.

Mouse:



Click left mouse button, pointing at any field:
Daisy will try to reach this field, if the route is not too difficult.

Click right mouse button, pointing at the ground on the left or right to Daisy:
Daisy will dig a hole on her left or right, if this is possible.

Key CTRL + left mouse button:
Daisy will dig a hole on her left, if this is possible.

Key CTRL + right mouse button:
Daisy will dig a hole on her right, if this is possible.

Joystick:
(Unfortunately, you can only use certain types of joysticks. Please refer to Dialog Box Game Settings 
(Shortcut F5)).

Moving the handle of the joystick:
Daisy will walk in the direction the joystick is pointing.

Left button (button 1) of the joystick:
Daisy will dig a hole on her left, if this is possible.

Right button (button 2) of the joystick:
Daisy will dig a hole on her right, if this is possible.



Pieces of the Game
Also refer to:

Playing Daisy's Garden 2
Tips and Tricks for Playing

Garden File
Garden
Pieces of the Game
Fields

The Main Piece:

Daisy
The player controls Daisys movements. She can walk on the ground, climb ladders and she can 
move hand over hand along a rope. She can also dig holes in the ground. Daisy picks flowers and
collects fruits simply by walking over them. 

Animals:

The Marmot
The marmot will try to catch Daisy as soon as it has spotted her. Some will see her straight away 
others only if she gets too close to them. Like Daisy it can walk on the ground, climb ladders and 
move hand over hand along a rope. Sometimes it will steal an apple but will usually drop it again 
somewhere. A marmot, which jumps into a hole dug by Daisy, will always let go of the apple first. 

If the marmot stops in a hole Daisy can quickly run over it. Just do not let her stop.

The Caterpillar
The caterpillar crawls constantly from left to right and back again. Only a hole in the ground can 
stop it. Daisy must not touch the caterpillar!

The Mole
The mole is a peaceful fellow, who will only appear sometimes. But he does not like Daisy to 
touch him.

Things to Pick - Fruits:

The Apple
The apple is a tasty fruit. Sometimes a little worm will peek out, but that does not bother Daisy. 
However, it is ever so annoying, if a marmot steals an apple and drops it in some ridiculous place.
Daisy must try and get back apples taken away by a marmot.

The Lemon
The lemon is a tasty fruit, which can be picked easily.

The Cherries
The cherries are tasty fruits, which can be picked easily.

The Pineapple
The pineapple is a tasty fruit, which can be picked easily.

Things to Pick - Flowers:

The Sunflower
The sunflower is a pretty flower, which can be picked easily.



The Tulip
The tulip is a pretty flower, which can be picked easily.

The Daisy
The daisy is a pretty flower, which can be picked easily.

The Rose
The rose is a pretty flower, which can be picked easily.

Things to Harvest - Vegetables:

Garlic
Garlic causes an unpleasant smell. If Daisy eats garlic, the marmot will stay away from Daisy for 
a while. But watch out! She still must not touch it!

The Invisible Making Mushroom
If Daisy eats an invisible making mushroom it will    as its name says - make her invisible to the 
marmot and the caterpillar for a little while. Then Daisy can go past them without danger.

Spinach
Spinach is healthy and supplies strength. If Daisy eats some, it will give her more time to reach 
the exit of the garden

The Carrot
The carrot is a healthy vegetable, which can be collected easily.

Thing to Collect - Keys:
The Key
There are keys in red, yellow and green. They will open doors of the same color. However, they 
can only be used once and Daisy can only collect one of each color at a time. 

Thing to Collect - Clues:

The Clue
The clue will tell you important things to know, for Daisy to reach the exit of a garden.

The Surroundings:
The Lift
Daisy can use a lift. She can enter or leave a lift only when it stops.

The Ground
Daisy can walk on the ground or dig it up. Daisy can jump in a hole she has dug, but be careful: 
the wind will blow the soil back into the hole after a while, and should Daisy still be in it...

The Ladder
Daisy can climb ladders up and down.

Some ladders will only appear when Daisy has collected all fruits and flowers. Other ladders will 
disappear, when Daisy has collected everything, but you will not know which ones do which until 
then. 

The Rope
Daisy can move hand over hand along the ropes, and let go if necessary.

The Sky
Sometimes there will be sun and clouds.

The Fence



Daisy can walk along the fence, but she must not fall onto it or she will get hurt.

The Hedge
Daisy can walk along the hedge, but she must not fall into it or she will get hurt.

The Sign
Sometimes there will be a sign which points Daisy in the right direction.

The Water
Water is dangerous. Daisy must not fall into it.

The Door
There are doors in red, yellow or green. In order to open one of the doors Daisy must have 
collected the matching key first (same color as the door).



Tips and Tricks for Playing
Also refer to:

Playing Daisy's Garden 2
Pieces of the Game

Garden File
Garden
Pieces of the Game
Fields

After the first easy gardens it will become more difficult for Daisy to pick all fruits and flowers and to reach 
the highest point of the garden. Every garden is a new challenge.

It often depends on the correct order in which the Daisy picks fruits and flowers. If she chooses a wrong 
route, a fruit will soon become unreachable forever. If she is lucky a ladder will appear or there may be a 
secret passage in the ground, once Daisy has collected the last fruit.

Digging is an essential technique to get fruit being in the ground or to keep marmots or caterpillars away. 
If a marmot is in a hole Daisy can easily walk over it. Plus, the marmot will always let go of an apple, 
before jumping into the hole. If Daisy digs deep holes to collect vegetables she must make sure that the 
hole will be wide enough, as she can never dig directly beneath herself. 

Sometimes Daisy will be caught in a difficult track and cannot find a way out anymore. In that case you 
will have to re-start the garden (Shortcut F3). Consequently you will lose one figure, but for every garden 
you have already completed, you will have received an additional figure.

If a garden is particularly difficult for you, you can also select another garden in the Dialog Box Game 
Settings (Shortcut F5).

The gardens are integrated in so-called garden files. A file consists of approx. 20-50 gardens.



Registration
Also refer to:

Registration and License Agreement
Order Form

Thank you for your interest in Daisy's Garden 2. 

The authors of this game have taken a lot of trouble to give you lots of fun with this game.

This game is shareware. This means that you are allowed (and even encouraged!) to copy and pass on 
all files of this game, as long as the files are kept in the original version.

In the shareware version you can only play the first 6 Gardens per Garden File and only edit 3 gardens 
per garden file. In addition there are registration notes, which will have surely led you to this help page.

If you like this game, we will ask you to get registered at a really low rate so that we can continue to 
develop good value entertaining games for you.

Once you have got registered, we will send you a personalized registration password with your name, 
which you will enter in the program. With this the program will identify you as a registered user of Daisy's 
Garden 2 and will remove all restrictions of the shareware version. You will only need to enter the 
registration password once, as it will be saved by the program.

The full version of Daisy's Garden 2 consists of the shareware version and a valid registration password. 
There is no separate disk version.

The registration password, which is available from DM 20.00 or US$ 15.00 (see Order Form) from us and 
which we will send to you in a standard letter, has many advantages for you:

+ Elimination of additional floppy disks and expensive protective envelopes. 

+ Letters are handled faster than parcels, therefore you will receive the full version earlier.

+ You can always get hold of the latest shareware version of Daisy's Garden 2 from us or from your local
shareware distributor or you may download it from the Internet. Your registration password will remain 
valid.

+ We will avoid costly management and stock keeping, which will save you money on the registration 
fee.

Registration is rather simple:

+ Print Order Form, fill in and send it to the following address:

Ingenieurbüro für Softwareentwicklung
Dipl. Ing. Frank Burkart
Hertzstr. 29

D-76287 Rheinstetten
Germany

We offer good value multiple licenses for the use on several computers for institutions such as 
kindergartens, schools, children homes, after school clubs and youth clubs. Prices on application.

Please feel free to contact us, should any queries arise about the registration procedure and about 
shareware or if you simply wish to share proposals and ideas. Please do not forget to include an 
international reply coupon since we would be unable to answer your inquiry otherwise.

Note: We also develop software and device drivers to your personal specifications for 
all Windows operating systems with Excel, Access, Visual Basic, C++ and 
Assembler. Please do not hesitate to contact us.





To print this order form click    "File" on the toolbar and select "Print Topic" in the menu.

Order Form

Ingenieurbüro für Softwareentwicklung
Dipl. Ing. Frank Burkart
Hertzstr. 29

D - 76287 Rheinstetten
Deutschland

Order Fax
++49 7242 952321

I acknowledge the terms and conditions in the Registration and License Agreement and order Daisy's 
Garden 2 Version 1.06e: (Please, fill in form and tick where applicable)

Name:
Address:
City:
Zip Code:
Country:

O Registration password
including the passwords for editing garden files daisyg.dgf and daisyg2.dgf.
Altogether over 50 extensive gardens.

The registration password and the shareware version of Daisy's Garden 2 
combined are the full version. We would like the registration password to be 
issued under the following name (please, print name): 

First name: Last Name:

DM 20.00

O Passwords for editing and playing the garden file dgarden.dgf.
There are the 50 gardens of the first version of Daisy's Garden. To use these 
passwords you will also require a registration password.

Registered players of the first version of Daisy's Garden will get these passwords 
free of charge, please state your serial number and the password:

Serial number: Password:

DM 10.00

O Our latest shareware programs on CD-ROM, including Daisy's Garden 2 (English 
and German) and Mystic Marbles (English and German)

DM 15.00

A handling and shipping charge may apply, please tick method of payment:

O Cash (equivalent of the price in DM) in any of the mentioned currencies (US$, 
SFr or EU-currencies).    Please send cash in registered letters only. 

(e.g. DM 20.00 = US$ 15.00 = FF 70.00 = ÖS 150.00) Please ask for current 
exchange rates at your local bank.

No
handling

charge

O Please charge my credit card O    Visa O    Eurocard/Mastercard

Number: Valid until:

DM 5.00

-------------



Total

Please note that additional VAT will not apply for orders other than from Germany.

Date, Signature (parent/guardian):    ______________________________________

We are interested in your opinion!
We would very much appreciate if you filled in this survey even if you decide against getting registered. 
This will enable us to develop even better programs in the future.

I use the following computer equipment:

Processor (386, 486, Pentium, Pentium II, etc.):
RAM (4 MB, 8 MB, etc.):
Display (800 * 600 * 256 colors, etc):
Sound card (Yes/No)            CD-ROM Drive (Yes/No)            Joystick (Yes/No)
Operating System (Windows 3.1, Windows 95, Windows NT, etc.):
I can access the Internet (email address?):

I really liked the following about Daisy's Garden 2:

This could be improved about Daisy's Garden 2:

I saw the shareware version of Daisy's Garden 2 at

O CD-ROM shareware collection or Shareware distributor (title, publisher, address):

O Internet or On-line service (WWW page or FTP Server):

O Other:

Ideas, suggestions, error reports:



Dialog Box Game Settings
Also refer to:

Troubleshooting

In this dialog box you can make general game settings. The settings will be saved after the game has 
been finished.

Name:
Enter the player's name. The program will save the name entered last.

Start Garden No.:
Choose the Garden in the open Garden File, in which the player wants to start a game. This will 
also enable you to skip a difficult garden.

Faster <-V-> Slower:
Faster <-V-> Slower:

Adjust the slide control for a faster or slower game speed. For slower computers we recommend 
a slower speed. The program will save the speed chosen last.

Sound Effects:
Choose whether you want to hear sound effects or not. You can only hear sound effects if your 
computer has a Windows compatible sound card. For slower computers we recommend not to 
use sound effects. The program will save the setting chosen last.

Music:
Choose whether you want to hear music or not. You can only hear MIDI Music Files, if your 
computer has a Windows compatible sound card. For slower computers we recommend not to 
use music. The program will save the setting chosen last.

Despite being equipped with a sound card, you may experience difficulties with MIDI music files 
with some computers. Please contact the manufacturer of your computer.

Scrolling Effects:
A lot of gardens are so big that they will not be fully displayed on your screen. However the 
immediate surroundings of Daisy will always be shown. Scrolling effects will allow you to choose 
how fast the surroundings will be updated. For slower computers we recommend the setting "slow
computer". The program will save the setting chosen last.

Joystick:
Adjust your computer to joystick setting, if available. The program will save the setting chosen 
last.

Disable
No joystick is connected to your computer or it does not work correctly with Daisy's 
Garden 2. If the test field does not work properly, you must choose setting disable 
otherwise the game may not work properly. For slower computers we recommend this 
option.

MM-driver (Win95)
A special driver is installed for your joystick. Ask the manufacturer of your computer and 
of your joystick, if such a driver is available. We have only found such drivers to be 
available for Windows 95.

BIOS (Win31)



Daisy's Garden 2 checks the hardware of the computer directly. This does not work with 
all computers. In some cases the game may be ended by the operating system when 
choosing this option.

Center
Only available if you have chosen the setting BIOS. Push your joystick right down in all 
directions. By doing this, Daisy's Garden 2 will try to recognize your joystick. Check in the 
test field whether you have been successful. Save with OK if you are satisfied.

Test Field
Check in the test field, whether or not your joystick works correctly with Daisy's Garden 2 
should you have chosen the option MM-driver or BIOS.

Let go of your joystick. The green point must be inside the black rectangle. If not, calibrate
or center your joystick.

Move the handle of your joystick. You must be able to move the green point out of the 
black rectangle in all directions.

Press the right and the left button (button 1 and 2) of your joystick. A red point will appear 
in the test field for each button.



Dialog Box Hall of Fame
In this dialog you can admire the best players of Daisy's Garden 2. You may be among them if you play 
this game well enough.



Dialog Box Registration
Also refer to:

Registration
Order Form

In this dialog box you have to enter your registration password.

You will receive your registration password when getting registered.

After you have entered your valid registration password the dialog box Registration will disappear for 
good. All restrictions will be removed from the game; e.g. only the first 6 Gardens per Garden File could 
be played and only 3 gardens per garden file could be edited before.

Registration Password:
Enter the registration password here and click "OK".

Continue with Shareware:
If you do not have a registration password so far, you may try out Daisy's Garden 2. Click 
"Continue with Shareware". In this case you can only play the first 6 gardens per garden file and 
only edit 3 gardens per garden file. That is why you should get registered as soon as possible.



Toolbar: File - Commands Options
New

Will create a new Garden File to enter new gardens.

Icon: Shortcut: Ctrl-N

Open...
Will open an existing garden file to play or edit.

Icon: Shortcut: Ctrl-O

Close
Will close the garden file in use. You will be asked whether you want to save the changes 
to the garden file, before the application will be closed.

Save
Will save the garden file in use.

Icon: Shortcut: Ctrl-S

Save as...
Will save the garden file in use under a different name.

Info...
Will show information, e.g. about the author of the garden file in use.

1, 2, 3, 4
Will open the garden files used last to play or edit.

Exit
Will exit Daisy's Garden 2.



Toolbar: Play    Commands Options
Start Game

Will start a new game. The player will get three Daisy figures.

Icon: Shortcut: F2

Re-start Garden
If Daisy has got caught hopelessly, you will lose one figure and get another chance to try 
and finish the garden.

Icon: Shortcut: F3

Pause
Will pause the game, if you have to attend to an urgent matter. It will also pause if you 
switch to another Windows application.

Icon: Shortcut: F4

End Game
Will end the game in use. You will then have to start from scratch again.

Settings...
Will show the Dialog Box Game Settings, in which you can set in the player's name, the 
speed and the sound effects.

Icon: Shortcut: F5

Faster
Will accelerate the game.

Icon: Shortcut: Ctrl-Q

Slower
Will slow down the game.

Icon: Shortcut: Stag-S

Hall of Fame...
Will show the Dialog Box Hall of Fame, in which you may admire the best players of 
Daisy's Garden 2.



Toolbar: Help    Commands Options
Index

Will show the Contents of the help for Daisy's Garden 2.

Using Help
Will show you how to use the on-line help for Windows.

Info...
Will show you a dialog box with the version number of Daisy's Garden 2.



Toolbar: Edit - Commands Options
Undo

Will undo the last action, if possible.

Shortcut: Ctrl-Z

Cut
Will cut part of or a whole Garden and put it onto the clipboard. You can insert the 
contents of the clipboard in a garden again.

Cutting a complete garden:

+ Highlight the name of the garden in the list on the left side.

+ Cut the garden with "Cut". The garden will be put onto the clipboard.

Cutting part of a garden:

+ Click    "Edit"

+ Highlight the area in the garden you want to cut.

+ Cut the highlighted area with "Cut". It will then be put onto the clipboard.

Icon: Shortcut: Ctrl-X

Copy
Will copy part of or a whole garden and put it onto the clipboard. You can insert the 
contents of the clipboard into a garden again.

See "Cut" for instructions.

Icon: Shortcut: Ctrl-C

Paste
Will paste the contents of the clipboard as part of a garden or turn it into a new garden.

Pasting a whole garden:

+ Highlight a garden in the list on the left side with your mouse.

+ Paste an additional garden in this section from the clipboard by clicking    "Paste". 

Pasting part of a garden:

+ Select    "Edit" on the toolbar.

+ Select the area in the garden, in which you want to paste the contents of the clipboard.

+ Paste the contents of the clipboard in the chosen area by clicking "Paste". The original
part of the garden will be overwritten. If you have only selected one field, the whole 
contents of the clipboard will be pasted otherwise only the section will be replaced.

Icon: Shortcut: Ctrl-V

Delete
Will delete part of or a whole garden non-retrievably.

See "Cut" for instructions.

New Garden
Will create a new garden in the Garden File.

Insert Rows



At first you will have to highlight the rows in the garden, which you want insert. You will 
insert as many rows as you have selected.

Delete Rows
At first you will have to select the rows in the garden, which you want to delete. There will 
be as many rows deleted as you have selected.

Insert Columns
At first you will have to highlight the columns in the garden, where you want to insert new 
columns. You will insert as many columns as you have selected.

Delete Columns
At first you will have to select the columns in the garden, which you want to delete. There 
will be as many columns deleted as you have selected.

Properties...
Will set the properties of a garden file, of a garden or of a Piece of the Game.

Setting properties of a garden file or a garden:

+ Highlight the name of the garden in the list on the left side.

+ Set properties by clicking "Properties". The Dialog Box Properties Garden File and 
Selected Garden will appear in which you can set properties.

Setting properties of a piece of the game:

+ Go to "Edit" on the toolbar

+ Highlight the piece of the game for which you want to set properties.

+ Set properties by clicking "Properties". The Dialog Box Properties Selected Piece of 
the Game will appear in which you can set properties.



Toolbar: Tools - Commands Options
Test Garden

Will test the current Garden.

Shortcut: Ctrl-T

Grid
Will show or hide the grid lines in gardens. This will make it easier for you to edit or to get 
an overall view of your garden.

Icon: 

Select & Edit
This will select the Pieces of the Game, which you want to edit, copy, cut etc.

Icon: 

Draw
By clicking this icon you can draw a movable piece of the game in the garden.

Icon: 

Draw Rectangle
By clicking this icon you fill a whole area in the garden with a movable piece of the game.

Icon: 

Air
Clicking this icon will enable you to draw the fixed piece of the game "space.

Icon: 

Ground
Clicking this icon will enable you to draw the fixed piece of the game "ground.

Icon: 

Ladder & Rope
Clicking this icon will enable you to draw the fixed pieces of the game "ladders and ropes.

Icon: 

Door
Clicking this icon will enable you to draw the fixed piece of the game "door.

Icon: 

Water
Clicking this icon will enable you to draw the fixed piece of the game "water.

Icon: 

Daisy
Clicking this icon will enable you to draw the movable piece of the game "Daisy.

Icon: 

Marmot



Clicking this icon will enable you to draw the movable piece of the game "marmot.

Icon: 

Caterpillar
Clicking this icon will enable you to draw the movable piece of the game "caterpillar.

Icon: 

Lift
Clicking this icon will enable you to draw the movable piece of the game "lift.

Icon: 

Key
Clicking this icon will enable you to draw the piece of the game "key.

Icon: 

Fruit
Clicking this icon will enable you to draw the piece of the game "fruit.

Icon: 

Vegetable
Clicking this icon will enable you to draw the piece of the game vegetable.

Icon: 

Flower
Clicking this icon will enable you to draw the piece of the game "flower.

Icon: 

Clue
Clicking this icon will enable you to draw the piece of the game "clue.

Icon: 



Toolbar: Window - Commands Options
New Window

Will open a new window in the current Garden File. Alterations in any window will be for 
all open windows of the garden file.

Cascade
Will re-arrange all open windows so that they are cascaded.

Tile
Will re-arrange all open windows so that you can see them at the same time.

Arrange Icons
Will arrange the icons of all minimized open windows in a logical order.

1, 2, 3...
Will maximize the corresponding open window.



Toolbar: Registration - Commands Options
The dialog box "Registration" will not appear anymore, once you have entered your registration password.

Registration...
Will show the Dialog Box Registration, in which you will have to enter your registration 
password in order to access all functions of Daisy's Garden 2.

Info
Will assist you with the Registration of Daisy's Garden 2.

Order Form
Will view a help file with an Order Form for Daisy's Garden 2.



Editing Gardens
Also refer to:

Pieces of the Game
Tips and Tricks for Editing

Garden file
Garden
Pieces of the Game
Fields

Once you have gone into the editing file of Daisy's Garden 2 you can construct new gardens.

We will give you an example to show you how to do this most effectively. We recommend that you print 
this help page and proceed step by step.

Once you have gone through this example, you should be able to edit gardens on your own.

Creating a new Garden File:
+ Select "New" via the "File" menu on the toolbar.    A window with an empty garden file will appear.

+ The window of the garden file will be divided in two areas: On the left you will find a list with the titles of
all gardens of a garden file. You can create a maximum of 50 gardens (in the shareware version a 
maximum of 3) per garden file. On the left you may choose a garden by clicking the title of the garden. 
The selected garden will appear on the right. If a garden happens to be too big for the window, use the
scrollbars to move the window contents.

Creating a new Garden in the Garden File.
+ Select "New Garden" via the "Edit" menu on the toolbar. A garden file will be added after the last 

chosen garden of the garden file.

+ The garden will already contain a background (air) and the piece of the game "Daisy" on the top left.

Pieces of the Game
+ You will add the pieces of the game to the garden, which will give it its distinctive look. Pieces of the 

game are e.g. air, ground, of course Daisy, flowers and marmots.

+ There are two types of pieces of the game in Daisy's Garden 2: the fixed pieces and the movable 
pieces.

+ The fixed pieces of the game are air, ground, ladders / ropes, doors and water. The fixed ones make 
up the background, the scenery of the garden. Fixed pieces of the game always stay in the same 
place, but they can alter their state, for example doors open and close.

+ The movable pieces of the game are Daisy, marmots, caterpillars, lifts and all things Daisy can collect. 
The movable ones fill Daisy's Garden 2 with life. They can change their position, for example marmots,
or things, which can be collected, which disappear completely.

+ Most pieces of the game have several properties. For example the piece "Air" includes the properties 
"Sun", Fence" and "Sign", the piece "Ladder" contains "Ladder appearing at the end" and "Rope".

Creating the Background
+ At first the background is filled with the piece of the game "Air".

+ Adding the piece of the game "Ground": Go to    "Tools" on the toolbar and choose "Draw" followed 
"Ground" from the menu. Now move the cursor across the garden, while pressing the left mouse 
button. All fields, which the cursor touches, will be turned into the piece of the game "Ground".



+ Adding ladders: Click    "Tools" on the toolbar and select the command "Ladder & Rope". You can also 
click the relevant icon on the icon toolbar. Now click on all fields in which you wish to draw ladders.

+ Transforming a ladder into a rope: Use the right mouse button to click on the ladder you want to turn 
into a rope. A context menu will appear. Select the command "Properties...". The dialog box Properties 
Selected Piece of the Game will appear in which in which you can find a list of all available initial 
states. Select the initial state "Rope"

+ Adding further ropes: The editor has saved the last initial state. Just click on the fields in which you 
want ropes to appear. The ropes are being drawn then.

+ You can use any of the other fixed pieces to form the background.

Adding movable Pieces of the Game
+ Adding flowers: Select Flower via the Tools menu on the toolbar. Use the left mouse button to click the 

fields in which you want flowers to appear. The movable piece of the game is on the track now, which   
unlike when drawing ladders    will not change.

+ A field can only contain one movable piece at a time. If you draw a movable piece into a field, which 
already contains one, the original piece will be deleted. 

Highlighting Several Fields
There are numerous options of what you can do with highlighted fields.

+ Go to "Select & Edit" via the Tools menu on the toolbar. Use the left mouse button to click the fields 
you want to highlight and keep pressing the mouse button. Move the mouse to the field which is on the
bottom right of the area you wish to highlight. A frame will appear around the selected fields.

+ You may always change the size and shape of the highlighted area by clicking on the small black 
rectangles of the frame and subsequently dragging them (use left mouse button).

Moving Several Fields
+ If you wish to move several fields to another part of the garden move the cursor to the center of the 

selected fields. Use left mouse button to click and drag the fields to the area you wish to move them to.
A frame will show you your current position.

+ Release the mouse button when you have reached the designated area. The selected fields have 
been moved. The former area of the fields will automatically be filled with "Air" whereas the original 
fields of the new area will have been deleted. If you are not satisfied with the results, go to Edit on the 
toolbar and click    Undo. This will take you back to where you were before you moved the fields.

Selecting a Movable Piece of the Game
+ Select a movable piece of the game, for example a flower. Go to Select & Edit via the "Tools" menu on 

the toolbar".

+ Use the left mouse button to click on the field containing the movable piece. Only click once and let go 
immediately. Take care not to move the mouse while clicking, as you would highlight the whole field
rather than the movable piece only.

+ The highlighting of movable pieces differs from the one of fixed pieces. You can only highlight one 
movable piece at any time.

Cutting a Movable Piece of the Game onto the Clipboard
+ To cut a movable piece onto the clipboard, select Cut via the "Edit" menu on the toolbar.

Inserting a Movable Piece of the Game from Clipboard
+ Select the field, in which you want to paste the movable piece you have cut the last. Select Paste via 

the "Edit" menu on the toolbar.



 Distinctive Properties of Movable Pieces of the Game
+ Some movable pieces have distinctive properties. Some marmots, caterpillars and lifts may be 

restricted to moving within a rectangular area of fields. Also you can assign a text to a clue.

+ Due to these restrictions f. ex. lifts may only use a certain space to move up and down or marmots and
caterpillars must not leave their designated area.

Restricting the Movement of Marmots, Caterpillars and Lifts
+ Draw this kind of movable piece of the game. Then assign the required properties to it.

+ The assignment of properties consists of two parts: the smaller rectangle directly on the piece and a 
larger frame, which will always encircle the whole garden. You will find small black rectangles on this 
frame, which you can use to adjust its shape and size. To do this, click on one of the small rectangles 
using the left mouse button. Keep mouse button pressed while moving the mouse thus changing the 
appearance of the frame.

Assignment of a Text to the Piece of the Game "Clue"
+ Insert a "Clue".

+ Click "Clue" (use right mouse button). A context menu will appear. Go to "Properties...". The Dialog 
Box Properties Selected Piece of the Game will appear in which you can enter the text of the clue.

Entering the Title of the Garden.
+ Click the title of the garden you want to change in the list of gardens on the left side (use right mouse 

button). A context menu will appear. Go to "Properties....". The Dialog Box Properties Garden File and 
Selected Garden  will appear in which you can enter the title of the garden.

Saving a Garden File
+ Go to "File" on the toolbar and click "Save". Enter a file name in the dialog box.

Testing the Garden 
+ Go to "Tools" on the toolbar and click "Test Garden". You may now play the garden you have just 

constructed. When you have finished, press shortcut CTRL-F4 to carry on working on your garden.



Tips and Tricks for Editing
Also refer to:

Editing Gardens
Pieces of the Game

Garden file
Garden
Pieces of the Game
Fields

We would like to emphasize that we encourage all players of Daisy's Garden 2 to make their own garden 
files with gardens and to pass them on to other players.

Please feel free to send any of your own gardens to us:

Ingenieurbüro für Softwareentwicklung
Dipl. Ing. Frank Burkart
Hertzstr. 29

D - 76287 Rheinstetten
Germany

In case of great demand we would like to forward a collection of gardens constructed by players to other 
players.

However you must meet the following conditions:

+ You must be a registered user of Daisy's Garden 2

+ A garden file must contain a minimum of 20 gardens

+ You must have stated your name and full address in the Dialog Box Properties Garden File

+ Your garden file must not contain any of the following: violence, pornography and/or racism

+ Your garden file must not contain computer viruses

Note: We are not liable for any programs and/or garden files sent by you voluntarily. You are 
neither entitled to the publication of your gardens nor are we obliged to return your 
gardens.



Dialog Box: Properties Garden File and Selected Garden
In this dialog box you can set the properties for the garden file and the current Garden.

Author:
Enter your name and address here when you have finished designing your garden. Your name 
and your address will always be displayed when you are asked to enter passwords for this garden
file.

Comments of the Author:
Please enter important information on the garden, for example how and where to get the 
passwords for this garden file. The comments will always be displayed when you are requested to
enter the passwords for this garden file.

Password for Editing:
Please enter your password here, if you want the game only to be edited by somebody who 
knows the password. 

This will protect your garden file against unauthorized changes.

Password for Playing:
Please enter your password here, if you want the game only to be played by someone who knows
the password. 

You may wish to charge interested players a small fee to obtain their password.

From Garden No.:
Enter the number of the garden as of which a password will be required.

This will enable other interested players to try out some of your gardens regardless of the 
password.

Title:
Enter a title for the garden here. The title will be displayed when playing this garden.

Size X:
Enter the width of the garden here. You may use sizes from 1 to 50. If you widen the garden, "Air" 
will be added. If you shrink the garden, the corresponding fields at the right margin will be 
removed.

Size Y:
Enter the height of the garden here. You may use sizes from 1 to 40. If you increase the height of 
the garden, "Air" will be added. If you shrink the garden, the corresponding fields at the bottom 
margin will be removed.

Timeout:
Enter the time in which a player will have to complete the garden. You may choose anything from 
20 to 1000.

MIDI Music File:
Enter the name of a MIDI Music File that you want to use as background music for this garden. 
Daisy's Garden 2 will search for this music file in the directory, in which the garden file is saved 
first, then in the directory, in which Daisy's Garden 2 is installed.

Browse:
This is where you can search for a MIDI music file.





Dialog Box: Properties Selected Piece of the Game
In this dialog box you can set the properties of a Piece of the Game.

Initial State:
Here you can set the initial state of the selected piece of the game. Most pieces have got 
numerous states. Use the mouse to choose the appropriate entry.

Starting Position:
Here you can set the starting position of a movable piece of the game. When editing a fixed piece
you will see its position.

You may also set the starting position by using the mouse (toolbar "Tools", then click "Edit") 
instead of using the dialog box.

Movement range:
Here you can set the movement range of a movable piece of the game. If you are editing a fixed 
piece or a movable piece, which is not subject to restricted movement, the necessary commands 
will not be available for use.

Set the amount of fields the movable piece of the game is allowed to move to the left, right, top 
and bottom from its starting position. Use 1 for any side for which you want the ability to move to 
be negligible.

You can also set the movement range by using the mouse (toolbar "Tools", command "Select & 
Edit").

Clue Text:
Here you can set the text for the movable piece of the game "clue". These fields will be invisible, 
when editing a another piece of the game.



Dialog Box: Garden File Info
In this dialog box you will find information about the current Garden file.

Author:
It is here that you will usually find information on who to obtain passwords from for this garden 
file.

Comments of the Author:
It is here that you will usually find information on how to obtain passwords for this garden file. 



Dialog Box: Enter Password Play
In this dialog box you will have to enter a password in order to be able to play this Garden.

Author:
It is here that you will usually find information on who to obtain the password from.

Comments of the Author:
It is here that you will usually find information on how to obtain a password.

Password Play:
Enter the password, which you have received from the author of the garden file here.

Once you have entered the correct password, it will be saved and Daisy's Garden 2 will not ask 
for it again.



Dialog Box: Enter Password Edit
In this dialog box you will have to enter a password in order to be able to edit this Garden File.

Author:
It is here that you will usually find information on who to obtain the password from.

Comments of the Author:
It is here that you will usually find information on how to obtain a password.

Password Edit:
Enter the password you have received from the author of the garden file here.

Once you have entered the correct password, it will be saved and Daisy's Garden 2 will not ask 
for it again.



Dialog Box: Garden File Open
In this dialog box you will have to enter which Garden File you want to open.

File Name:
Enter the name of the file you want to open or select a file name from the list.

Type of file:
Select the type of file you want to open. Daisy's Garden 2 can only use garden files file type .dgf .

Directories or Folders:
Select the directory or folder, in which Daisy's Garden 2 has saved the garden file, which you 
want to open.

Drives:
Select the drive in which Daisy's Garden 2 has saved the garden file, which you want to open.



Dialog Box: Garden File Save As
In this dialog box you will enter the name of the current Garden File, which you want to save under a 
different name.

File Name:
Enter the name of the file you want to open or select a file name from the list.

List Files of Type:
Select the type of file you want to open. Daisy's Garden 2 can only use garden files (file 
type .dgf).

Directories or Folders:
It is here where you select the directory or folder in which you want Daisy's Garden 2 to save the 
garden file.

Drive:
It is here where you select the drive in which you want Daisy's Garden 2 to save the garden file.



Dialog Box: Browse MIDI Music File
You will use this dialog box to search for a MIDI Music File.

File Name:
Enter the file name of the MIDI music file or select a file name from the list.

List Files of Type:
Select the type of the MIDI music file. Daisy's Garden 2 can only use MIDI music files (file 
type .mid).

Directories or Folders
Select the directory or folder for the MIDI music file here.

Drive:
Select the drive for the MIDI music file here.



Definition garden file

There are up to 50 gardens per garden file, which Daisy has to finish successfully.



Definition garden

In order to finish a garden and to get to the next one, Daisy has to collect all fruits, vegetables and flowers
and then reach the highest point of the garden via a ladder.



Definition Pieces of the Game

There are fixed and movable pieces of the game in Daisy's Garden 2.

The fixed ones are air, ground, ladders / ropes, doors and water. They make up the background of the 
garden. Fixed pieces must remain in the same place, but they can alter their state.

The movable ones are Daisy, marmots, caterpillars, lifts and everything Daisy can collect. They fill Daisy's
Garden 2 with life. Movable pieces can move to another position or they can disappear, for example the 
pieces to collect.



Definition Field

A field will always contain a fixed piece of the game (background). Sometimes you may also find a 
movable piece in it as well.



Definition MIDI Music File

A MIDI music file is a piece of music, which can be played through the soundcard installed in your 
computer. Refer to the manual of your soundcard, if it can actually play MIDI music files in Microsoft 
Windows.



Error
An error has occurred.

You have made a mistake. For example you have edited something incorrectly.



Toolbar and Status Lines
Toolbar

You will find icons for the most commonly used commands for Daisy's Garden 2 on the icon toolbar below
the menu toolbar.

Status Lines

You will find important information about Daisy's Garden 2 in the status lines.

On the bottom status bar you will find a short help text for the currently chosen command and it will show 
whether or not the numeric keypad is activated on your keyboard.

Clue: Switch off the numeric keypad on your keyboard so you can play Daisy's Garden 2 with arrow keys.

Additional Status Lines for Playing

You will find information about your current game on these status lines.

Upper Status Line
Record Score

Best score of the day.

Score
Points achieved in current game.

Garden 
Number of the garden in the current garden file, which is being played.

Figures
Number of figures available. Every game starts with 3 figures. If Daisy manages to finish 
a garden, you will get an additional figure.

Lower Status Line
Timeout

Time left to finish the current garden. Each garden will start with 100 units. However, 
these may be counted down at differing speeds. Therefore you will actually need to finish 
some gardens faster than others. 

Pieces Available
If Daisy has collected a key or garlic, it will be shown here. Note: Garlic will not keep for a 
long time!

Player
Name of the player currently playing. Go to "Play" on the toolbar and click " Settings" to 
enter your name.



Standard Settings of Microsoft Windows
Please refer to your Microsoft Windows manual, if you want to know more about using Microsoft Windows
and its standard settings.



Troubleshooting
Daisy's Garden 2 does not run properly on my computer. What can I do?

System Requirements
Question: What kind of computer do I need to play Daisy's Garden 2?

Answer: Daisy's Garden 2 can be played in Microsoft Windows © enhanced mode on every computer.

Operating system: Windows 3.1, enhanced mode, Windows 95 and Windows NT (better)
Processor: at least 386 DX, 33 MHz, we highly recommend: 486 SX, 33 MHz
RAM: minimum of 4 MB, we recommend 8 MB
Graphics card: VGA, we highly recommend Accelerator 800 * 600 with 256 colors
Hard disk: 2 MB space on disk
Sound card: Windows compatible sound card recommended
Mouse: Windows compatible mouse for editing Daisy's Garden 2 required
Joystick: Joystick with Windows MM driver recommended

Updated Versions of Daisy's Garden 2
Question: Which version of Daisy's Garden 2 am I using?

Answer: Go to "Help" on the toolbar and select dialog box "Info...". It is here that you will find the 
number of the version you are using.

Question: Where can I get the latest shareware version of Daisy's Garden 2?

Answer: Straight from the author. Address supplied further down. Note: A fee will apply. Please use the 
enclosed Order Form.

or: From a good shareware distributor.

or: From on-line services and from the Internet. Search for the files daisyg.zip, daisyge.zip. Your 
on-line service will tell you how to search for files.

or: From our WWW homepage: http://ourworld.compuserve.com/Homepages/FBurkart

Registration Password
Question: Daisy's Garden 2 requires a registration password. What does that mean?

Answer: Read the help page Registration. You will find detailed information there.

Question: I have got a registration password for an older version of Daisy's Garden 2. Where do I get an 
updated version?

Answer: The registration password is valid for all versions of Daisy's Garden 2 (subject to technical 
improvements). Obtain the latest shareware version of Daisy's Garden 2, address supplied 
further down.

Playing Daisy's Garden 2
Question: The garden is so difficult that I cannot finish it.

Answer: Go to "Play" on the toolbar and click "Options...". The Dialog Box Game Settings will appear. 
Select the next garden in "Start Garden No.".

Graphics
Question: My graphics card supports 256 colors, but only 16 colors will be shown.

Answer: Check if the installed graphic card driver really supports 256 colors in the current screen 
setting. Check Windows Setup and refer to Windows literature and your computer manual.



Answer: Some older graphics card drivers do not support a certain range of colors. In this case Daisy's 
Garden 2 can only be played with 16 colors.

Question: My graphics card supports 256 colors, but I cannot see the gardens at all.

Answer: Start Daisy's Garden 2 with the command line option /c16, to start up Daisy's Garden 2 with 16
colors.

Question: The screen keeps on flickering, especially while scrolling.

Answer: Most of the gardens are so big that they will not fit on your screen, except on very high 
resolution monitors (1600 * 1200 pixels). Therefore you will have to scroll the background and 
you will only see the section around Daisy. In order to make the game compatible with almost 
every computer, we were unable to program the graphics card directly but had to use the 
Windows-API.

Therefore the maximum playing speed available will depend on your graphics card and in 
particular on its driver. In most cases an optimized driver, which comes with your graphics card
should be installed. The standard Windows 3.1 drivers VGA and Super-VGA are probably too 
slow. If you use modern PCI- or VESA-Local-Bus-Accelerator cards with suitable drivers, 
scrolling will be done at an acceptable speed.

When comparing Daisy's Garden 2 with similar DOS games you will have to keep in mind that 
with today's standard resolution of 800 x 600 256 colors 8 times as much data will have to be 
processed as compared with 320 x 200 256 colors in DOS.

Here are some tips how you can probably achieve better scrolling effects:

1) Use a driver for 256 colors. Drivers for 16 colors or more than 256 colors are often slower.

2) Try the various options offered in the Dialog Box Game Settings (F5). Set the game speed 
<-V-> to "slower" and the scrolling effects to "slow computer". Please do try different settings.

3) Use smaller windows, for example half screen size.

Sound
Question: I have a sound card, but I cannot hear anything in Daisy's Garden 2, whereas in other 

Windows applications I will hear sound effects.

Answer: Go to "Play" on the toolbar and click "Options...". The Dialog Box Game Settings will appear. 
Check if the options "Sound effects" and "Music" are set properly.

Question: I have a sound card, but sound effects and music are played incorrectly.

Answer: Sound cards may differ enormously in quality. Disable the options "Sound Effects" and "Music"
if necessary.

Question: After setting the sound effects in Daisy's Garden 2, I cannot start up Daisy's Garden 2 because
of lack of memory or other reasons.

Answer: Open the file daisyg.ini via notepad.exe or another text editor in your Windows directory.. 
Overwrite the entry SoundEffects=1 with SoundEffects=0 and the entry MidiMusic=1 with 
MidiMusic=0.

Passwords
Question: Why do I only enter passwords once?

Answer: Once you have entered the correct passwords, Daisy's Garden 2 will save them in the file 
daisyg.ini in your Windows directory. You may delete the corresponding entries with a text 
editor, for example notepad.exe.

Question: I have forgotten a password.

Answer: There is no possibility to restore a forgotten password. It would be pointless for you to have a 



password if you could.

Joystick
Question: I cannot use my joystick with Daisy's Garden 2.

Answer: Check the following causes of error: Is the joystick connected properly? Can I use the joystick 
with another game? Is the joystick activated in the Dialog Box Game Settings and does the 
joystick work correctly in the test field? Is a mm-driver installed for your joystick? You may find 
that your joystick does not support Daisy's Garden 2 at all.

Question: Daisy stops unexpectedly, without me touching the joystick, the mouse or the keyboard.

Answer: You may have set a faulty joystick (or one which still needs calibrating or centering) in the 
Dialog Box Game Settings. Please, verify in the test field. If absolutely necessary disable the 
joystick (Option "Disable").

or: You may have connected your joystick to your sound card. However, some sound cards use 
this connection for playing MIDI music, too. Therefore the joystick and the MIDI music will 
overlap. You must either disable the music or the joystick in the Dialog Box Game Settings.

Miscellaneous
Refer to the files readme.txt and share.txt. They contain the latest information about Daisy's Garden 2.

If you have other problems with Daisy's Garden 2, you can also contact us under the following address:

Ingenieurbüro für Softwareentwicklung
Dipl. Ing. Frank Burkart
Hertzstr. 29

D - 76287 Rheinstetten
Germany

Phone: ++49 7242 952320
Fax: ++49 7242 952321

eMail: FBurkart@compuserve.com

We will try to help you. Do not forget postage (international reply coupon) as we would be unable to 
answer your query otherwise.

Please give us a detailed description of your problem, of your computer and if necessary a printout of 
your configuration files (config.sys, autoexec.bat, win.ini, system.ini).

Please refer to our WWW-Homepage, where we publish the latest information about Daisy's Garden 2 
and where you will find the latest program versions.

http://ourworld.compuserve.com/Homepages/FBurkart



Registration and License Agreement
Daisy's Garden 2 Copyright © 1996-1998 by

Ingenieurbüro für Softwareentwicklung
Dipl. Ing. Frank Burkart
Hertzstr. 29

D - 76287 Rheinstetten
Germany

Licenser means Ingenieurbüro für Softwareentwicklung, Dipl. Ing. Frank Burkart. Licensee means you or 
the person who wishes to use the full version of Daisy's Garden 2.

All rights reserved.

These terms and conditions are subject to the law of the Federal Republic of Germany.

You should read the following terms and conditions carefully before using this software. Unless you have 
a different license agreement signed by the licenser, the use of this software will acknowledge your 
acceptance of this license agreement and warranty.

1. Shareware Version
Daisy's Garden 2 is not free software. You are hereby licensed to use this software for evaluation 
purposes without charge. You must accept the restrictions of the shareware version.

The following terms and conditions apply for the distribution of the shareware version of Daisy's Garden 
2.

Distribution of the Shareware Version
You are allowed to copy and pass on the shareware version of Daisy's Garden 2 as often as you wish 
provided that

      * all files remain unchanged

      * all files stay together

      * you do not    guarantee the perfect working condition of this program

      * when passing on Daisy's Garden 2 you will emphasize that this product is shareware and that 
therefore a fee will apply to get registered if you want to use the full version of this program in the 
future

      * you do not pass on your registration password or any other passwords

Professional shareware dealers, who deal with Daisy's Garden 2, should inform the licenser that they 
distribute Daisy's Garden 2 to ensure that they will always receive an updated version.

Disclaimer of Warranty
The licenser of Daisy's Garden 2 has no influence on the distribution of the shareware version of this 
product. Therefore they are fully exempt from any liability or guarantee. A user must assume the entire 
risk of using this software.

2. Registered Version (Full version)



Prior to receiving a registration password for the software program Daisy's Garden 2, the licensee must 
acknowledge the following terms and conditions 

Registration Password and Full Version
The full version of Daisy's Garden 2 consists of the shareware version and a registration password 
containing information about the registered user, for example the name of the user.

The registration password is the only proof of a correct registration and consequently the purchase of the 
full version of Daisy's Garden 2.

Permitted Use of Daisy's Garden 2
The licenser grants the licensee the exclusive and personal right (license) to install the full version of this 
software in one computer. The transfer to another workstation is permitted provided that the software will 
be used solely on one computer at any time. 

Passing on of Software
It is explicitly prohibited to pass on the full version of this software, the registration password or any other 
passwords by any means.

Limitation of Warranty and Liability
The latest developments in technology exclude any guaranties on perfect working conditions of software 
in general.

The licenser of this software guaranties that this software will work essentially in accordance with its 
manual and that the data carrier of the software is free of any defect in its material or workmanship for six 
months after date of receipt of the full version of this software. The above is guaranteed by the licenser. 
This neither replaces nor restricts any guarantees or liabilities of the dealer you have received the 
software from.

This software and the accompanying files are sold "as is" and without warranties as to performance of 
merchantability or any other warranties whether expressed or implied. Because of the various hardware 
and software environments in which Daisy's Garden 2 may be put, no warranty of fitness for a particular 
purpose is offered.

Good data processing procedure dictates that any program must be thoroughly tested with non-critical 
data before relying on it. The user must assume the entire risk of using the program.    

Any liability of the licenser will be limited exclusively to product replacement or refund of the purchase 
price of the full version of this software, which has been returned to the licenser by the licensee with a 
copy of the receipt (as proof of purchase) attached.

This limited warranty does not apply if failure of the full version of this software is down to accidental 
damage, misuse or incorrect use. 

The licenser rules out any further warranty or liability on the full version of this software, its accompanying
manual and its data carrier.

Disclaimer of Liability for Subsequent Damage
Neither the licenser nor any of the dealers may be made liable for any damage caused by the use of this 
software or the incapability of doing so, even if the licenser has been informed about the possibility of 
such damage. In any case the liability of the licenser will be limited to the actual purchase price of the full 
version of this software.
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